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Question # 1
What is vector graphic animation?

Answer:-
Vector graphics" are different from "raster graphics" like jpg, gif, png, bmp graphics. And vector graphics use math formulas to draw animation shapes, while raster
graphics save millions of tiny colored dots to draw photos.
Read More Answers.

Question # 2
Can Flash .swf movies be very time consuming to edit?

Answer:-
Yes It is very laborious work to change a Flash web page quickly. For this reason, you will almost never see a dynamic content page like a news site utilizing Flash
for its rapidly-changing content. Instead, Flash is used more for decorative purposes, and for advertising and online gaming purposes.
Read More Answers.

Question # 3
I shoot underwater with a TTL strobe that does not allow you to set flash exposure compensation. How do I set fill flash with this set up?

Answer:-
Let's assume that you have an N80 body in an underwater case and are using underwater TTL strobes. Here you could set flash exposure compensation from the N80
body (assuming the case let you access that control). I'd tend to set the N80 to Standard TTL if I wanted to fiddle with flash levels, though, as in balanced fill-flash
modes you don't know what compensation the camera is already adding (i.e., you'll only get repeatable results with Standard TTL).
Read More Answers.

Question # 4
The F601/N6006 had a special control to set the fill-flash option on the body; Is there a similar way to set fill levels on the F90x/N90s and SB-28 combo?

Answer:-
If you're using an SB-24 or later and a modern Nikon body that doesn't have a built-in flash, you set fill levels on the flash. With your combo, you can set fill by
pressing the Minus button on the SB-28 three to five times (-1.0 to -1.7 stops). However, there's a caveat. If you have the camera set to Program (P) exposure mode
and the flash to TTL, you're in what is known as a "balanced" mode. In balanced modes, the camera tries to equalize the flash and ambient light levels. But, when
everything is on automatic, the camera can only set shutter speeds of 1/60 to 1/250, which might not let the camera set the proper ambient exposure. In dim light, for
example, the camera would underexpose the background (though the subject would be lit by the flash). Thus, if you dial in fill flash in this situation, both the ambient
light and the flash would be underexposed, ruining your shot. So, the caveat is this: don't set fill flash levels on your SB-28 unless you know that the ambient
exposure is going to be correct. For dim light, that may mean you need to set Slow or Rear flash sync; in bright light, that may mean you need to set High Speed (FP)
flash sync.
Read More Answers.

Question # 5
You understand from the SB-25 manual that the built-in, retractable bounce card is meant for use with the flash head in a vertical position?

Answer:-
I do (this is true of the SB-24, SB-25, SB-26, SB-28/28DX, SB-80DX). That's because it helps keep a little light from being lost, but more importantly, it provides
just a bit of catchlight in the subject's eyes (the bounce directly off the card).
Read More Answers.

Question # 6
It seems that most recommendations for using fill flash talk about using -1.3 to -1.7 stops of flash compensation. This seems like very little flash (compared to the
ambient exposure). Would not -.5 or -1 stop be better?

Answer:-
Most nature and scenic professionals use -1.3 to -1.7 stops for their fill flash setting because they are trying to do one thing only: increase shadow detail (an alternate
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way of saying this: decrease overall scene contrast). Why? Because exposures for slide film need to be biased to the brightest object in the scene (i.e., overexposure of
slide film is VERY bad). Since film has a limited dynamic range it can record with reasonable detail, if you set your exposure to put the highlight at the white point,
you often lose shadow detail. The purpose of the fill flash, therefore, is to raise the film's response curve at the shadow point without further blowing out the detail.
The -1.3 to -1.7 values are often just enough to pull another "stop" of useful shadow detail into an exposure without adding unduly to the highlight exposure. Films
like Velvia are especially troublesome,
Read More Answers.

Question # 7
I shoot underwater with a TTL strobe that does not allow you to set flash exposure compensation. How do I set fill flash with this set up?

Answer:-
Let's assume that you have an N80 body in an underwater case and are using underwater TTL strobes. Here you could set flash exposure compensation from the N80
body (assuming the case let you access that control). I'd tend to set the N80 to Standard TTL if I wanted to fiddle with flash levels, though, as in balanced fill-flash
modes you don't know what compensation the camera is already adding (i.e., you'll only get repeatable results with Standard TTL).
Read More Answers.

Question # 8
If We set slow sync as you suggest in answers on the many online forums you visit, would not we be opening ourselves up to blurred shots when the shutter speed
gets significantly below 1/60?

Answer:-
Yes and no. When you shoot with flash, there are two exposures going on: the flash exposure on the subject and the background exposure. If flash is the main source
of light, a stationary subject lit by it should always be sharp, as the slowest Nikon flash duration is about 1/830 of a second. The background, however, very well may
go soft or get blurred by poor handholding technique or subject movement. Many photographers have learned to use this to their advantage--there's one style of flash
that uses very long shutter speeds and panning/zooming/tilting to purposefully blur the background yet still use the flash to "freeze" the subject.
Read More Answers.

Question # 9
Is everyone required Flash Player plugin?

Answer:-
No because they do not like "blinking things" on their screens, some users choose to disable or not install Flash Player.
Read More Answers.

Question # 10
Can some organizations block Flash movies from being received through the Internet?

Answer:-
While this is partly motivated by fears of Flash viruses and Flash hackers, the greater motivation is disciplining staff. Many managers of private companies do not
want their employees playing Flash games at their office computers, so they will ban Flash movies at work through technical blockers on the network. Do not be
surprised if your employer chooses to implement a ban of Flash at your office.
Read More Answers.

Question # 11
Explain the Flash vs. Animated Images and Java Applets?

Answer:-
Animated images and Java applets are often used to create dynamic effects on Web pages.
The advantages of Flash are as under:
* Adobe Flash loads much faster than animated images
* Flash allows interactivity, animated images do not
* Flash does not require programming skills, java applets do
Read More Answers.

Question # 12
Who can View Flash?

Answer:-
In September 2000, NPD Research, the parent company of MediaMetrix, conducted a study to determine what percentage of Web browsers have Flash preinstalled.
The results show that 96.4% of Web users can experience Macromedia Flash content without having to download and install a player.
If you do not have the Shockwave Player installed you can download flash player for free from Adobe's site.
Read More Answers.

Question # 13
Who can Create Flash Movies?

Answer:-
To create your own Flash movies you have to buy a Flash program from Adobe.
The latest version from Adobe is Adobe Flash Lite (or Flash CS3 Pro).
If you do not have a Flash program, you can download a 30 days free trial version of Flash from Adobe.
Read More Answers.
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Question # 14
Where to Start the Adobe Flash?

Answer:-
After you have installed Flash at your computer, you should go through the flash help that are included in the program. Start Adobe Flash, click Help in the menu and
choose Lessons. 
These lessons will teach you the basics of Flash.
Read More Answers.

Question # 15
How to embed Flash in HTML?

Answer:-
After creating a Flash movie you choose File > Save As from the top menu to save your movie. Save the file as "YourFlahFileName.fla". 
To embed the Flash movie you just made into an HTML page, you should go back to your Flash program and do the following steps:
Step 1
Choose File > Open. Open a Flash movie you have created.
Step 2
Choose File > Export Movie.
Step 3
Name the file "YourFlahFileName.swf". Choose the location where the file is to be stored (in your Web folder). Click OK.
Step 4
Open the HTML page where you want to insert your Flash movie. Insert this code:
<object width="550" height="400">
<param name="movie" value="YourFlahFileName.swf">
<embed src="YourFlahFileName.swf" width="550" height="400">
</embed>
</object>
Read More Answers.

Question # 16
What is Flash Tweening?

Answer:-
Tweening comes from the words "in between".
With Tweening you can go from one keyframe to another and specify changes in the animation and let the Flash program create the frames in between.
Read More Answers.

Question # 17
What is default frame rate of the time line in frame per second?

Answer:-
A. 1
B. 12
C. 24
D. 30
Read More Answers.

Question # 18
What is the effect on the instances of a symbol if the symbol itself is changed?

Answer:-
A. All instances change accordingly.
B. Only future instances change accordingally.
C. Only the current selected instance changes accordingly.
D. Symbols cannot be changed once instance of the symbol have been created.
Read More Answers.

Question # 19
What is the key purpose of using layers in a timeline?

Answer:-
A. To determine when things appear in your movie.
B. To separate assets playing at different .
C. To handle the four button states
D. To organize the stacking order of assets.
Read More Answers.

Question # 20
Which of the following is the recommended character to use to separate target level paths levels?

Answer:-
A. / (slash)
B. $ (Dollar sign)
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C. _ (underscore)
D. % (percentage sign)
Read More Answers.

Question # 21
If the oilpump movie clip instance in path _root.car.engine.oilpump.clamp uses the following line of actionscript, _parent.someAction;, which movie clip instance is
being referenced?

Answer:-
A. Car
B. Engine
C. Oilpump
D. Clamp
Read More Answers.

Question # 22
How many levels does Flash MX support?

Answer:-
A. 20
B. 80
C. 100
D. 1000
Read More Answers.

Question # 23
In which level does the original movie resides?

Answer:-
A. 0
B. -0
C. 1
D. -1
Read More Answers.

Question # 24
What happens if an .swf is loaded into a already occupied level?

Answer:-
A. An error is thrown.
B. The new swf is rejected and the old one stays.
C. The old swf is unloaded and the new swf is loaded.
D. They share the same level
Read More Answers.

Question # 25
What are the correct statements consenting text field? (Choose Two)?

Answer:-
A. Embedded font outlines are shared by text fields using the same font.
B. Font Outlines for static for static text field are embedded in the SWF file by default.
C. Font outline for input text field are embedded in SWF file by default.
D. Individual font outlines are embedded in to the SWF file for each text field in the FLA file.
E. Font outlines for dynamic text fields are embedded in SWF file by default.
Read More Answers.

Question # 26
What is the function of trace?

Answer:-
A. Initiate the automatic debugging procedure.
B. Discover who has downloaded your movie.
C. Send String Values to the output panel.
D. Determine what objects are presents on stage ant any one time.
Read More Answers.

Question # 27
Which statement concerning symbol instance statements are correct? (Choose Two)?

Answer:-
A. The Hit State of a Button Symbol instance is invisible at runtime.
B. Graphic symbol instances may be directly controlled using action script.
C. If a fill color in a graphic symbol is changed, all instances of graphic symbols are changed.
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D. A movie clip symbol instance may have a different frame rate than the main timeline.
Read More Answers.

Question # 28
What is the advantage of progressive video download?

Answer:-
A. The frame rate of video file can be different from the frame rate of the SWF file.
B. Delivery of media is more secure than streaming video, because media does not get saved to the client cache when streamed.
C. To play the progressive download video, the entire movie must be downloaded before video will be start to play.
D. It usages less of the client memory and disk space than the streaming video download.
Read More Answers.

Question # 29
What methods are used to pass variables out of flash to a server side solution? (Choose Three)?

Answer:-
A. LoadVars
B. GotoAndStop
C. getURL
D. LoadMovie
Read More Answers.

Question # 30
What is needed when using static text to have font outline embedded in SWF file?

Answer:-
A. Nothing, Font outline are embedded by default.
B. Select new font in the library panel menu.
C. Select the alias button in the properties panel.
D. Select use device font form the properties panel.
Read More Answers.

Question # 31
A button instance is named circle_btn. Actionscript is placed on the main timeline so that the button is clicked a movie clip instance named rec_mc s width is changed
to 100?

Answer:-
A. circle_btn.onRelease = function() {this.width=100;}
B. circle_btn.onRelease = function() {rec_mc.width=100;}
C. Circle_btn.onRelease = function() {rec_mc.width=100;}
D. circle_btn.onRelease = function() {rec_mc._width=100;}
Read More Answers.

Question # 32
Which of the following charactor can be added to the identifire mylengthyvariable, to make it more redable?

Answer:-
A. Minus sign, "-" (e.g. my-lengthy-variable )
B. An underscore, "_" (e.g. my_lengthy_variable)
C. A period, "." (e.g. my.lengthy.variable)
D. A plus sign, (e.g. my+lengthy+variable)
Read More Answers.

Question # 33
What should be used in the name of constant?

Answer:-
A. Spaces between each word in the name
B. All capital letters
C. A number before character
D. A name followed by ()
Read More Answers.

Question # 34
What should be inferred by a variable named birthPlace_str?

Answer:-
A. It is a short-term variable and will be disposed of once its script is executed.
B. It can store multiple values
C. It is a string
D. It can hold 64 charactor
Read More Answers.

Copyright © https://www.GlobalGuideline.COM Page 6/23

https://www.globalguideline.com/interview_questions/
https://www.globalguideline.com/interview_questions/Questions.php?sc=Adobe_Flash_Interview_Questions_and_Answers_
https://www.globalguideline.com/interview_questions/Answer.php?a=Which_statement_concerning_symbol_instance_statements_are_correct_Choose_Two
https://www.globalguideline.com/interview_questions/Answer.php?a=What_is_the_advantage_of_progressive_video_download
https://www.globalguideline.com/interview_questions/Answer.php?a=What_methods_are_used_to_pass_variables_out_of_flash_to_a_server_side_solution_Choose_Three
https://www.globalguideline.com/interview_questions/Answer.php?a=What_is_needed_when_using_static_text_to_have_font_outline_embedded_in_SWF_file
https://www.globalguideline.com/interview_questions/Answer.php?a=A_button_instance_is_named_circle_btn_Actionscript_is_placed_on_the_main_timeline_so_that_the_button
https://www.globalguideline.com/interview_questions/Answer.php?a=Which_of_the_following_charactor_can_be_added_to_the_identifire_mylengthyvariable_to_make_it_more_re
https://www.globalguideline.com/interview_questions/Answer.php?a=What_should_be_used_in_the_name_of_constant
https://www.globalguideline.com/interview_questions/Answer.php?a=What_should_be_inferred_by_a_variable_named_birthPlace_str
https://www.globalguideline.com


Adobe Flash Interview Questions And Answers

Global Guideline . COM

Question # 35
Which of the following is most likely a class constructor?

Answer:-
A. CLASS_CONSTRUCTOR
B. ClassConstructor
C. classConstructor
D. class_constructor
Read More Answers.

Question # 36
The value of a variable of timeline scope will persist until:

Answer:-
A. The code block in which it was declared finishes executing.
B. The variable is removed using the clear keyword.
C. The player moves to a new scene.
D. The object to which it belongs no longer exists..3
Read More Answers.

Question # 37
To create a new global variable, birthyear, with an initial value 1968, the following code should be used:

Answer:-
A. new Global birthyear = 1968;
B. global(birthyear)=1968;
C. _global.birthyear=1968;
D. global.birthyear=1968;
Read More Answers.

Question # 38
To manually dispose of the variable myVar, the following code should used to prevent memory leaks:

Answer:-
A. delete myVar;
B. remove myVar;
C. myVar = null;
D. myVar = 0;
Read More Answers.

Question # 39
Which of the following is not a valid function name:

Answer:-
A. get_value
B. _getValue
C. 4ever
D. $1099
Read More Answers.

Question # 40
Which of the following is NOT a true statement about functions?

Answer:-
A. Function must specify exactly how many argument they can accept.
B. Function arguments should be comma-delimited.
C. Function name should not be start with a number.
Read More Answers.

Question # 41
Function can be assigned to identiires at runtime. Assuming sampleVar equals true, what will be returned by the following function?

Answer:-
Code:
    function sampleFunction(sampleVar){
      if(sampleVar==true){
       return "true";
       return "continue";
       }
    } 
A. Nothing
B. true
C. undefined
D. continue
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Read More Answers.

Question # 42
Which of the following if statement is correctly writen?

Answer:-
A. if firstName = "ABC" then {};
B. if {firstName = "ABC"} then ();
C. if(firstName == "ABC") {};
D. if(firstName = "ABC" || lastName="abc") {};
Read More Answers.

Question # 43
In which of the situations bellow would it be best to use a switch statement?

Answer:-
A. You need to test for two possible values.
B. You want to test for many possible values
C. You want a loop to run at leats once.
D. You only want one thing to happen if a condition is true.
Read More Answers.

Question # 44
Assuming myVar equals "fish", what will be treced by the following code block?

Answer:-
Code:
    switch(myVar){
    case "cat": trace("cat");
    case "fish": trace("fish");
    case "bird": trace("cat");
    default: trace("default");
    }
A. "fish"
B. "fish"
C. "fish default"
D. "fish bird default"
Read More Answers.

Question # 45
What is the key difference between while loops and do while loops?

Answer:-
A. do while loops cannot get stuck in a endless loop.
B. do while loops will always execute at leats ones.
C. while loops are deprecated in Flash MX.
Read More Answers.

Question # 46
Which of the following statements uses proper for loop syntax?

Answer:-
A. for(i=0, i<10, i++){}
B. for(i=0 ; i<10; i++){})
C. for((i=0)),(i<10),(i++){}
D. for(i=0 i<10 i++){}
Read More Answers.

Question # 47
To what does object drawing model refer?

Answer:-
A. drawing of regular shaped objects only
B. drawing of irregular shaped objects only
C. drawing of objects within symbol editing mode
D. drawing of objects that merge with other shapes
E. drawing of objects that cannot merge with other shapes
Read More Answers.

Question # 48
Which two statements about device fonts are true? (Choose two)?

Answer:-
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A. rotated text set in a device font can be rendered
B. device fonts are NOT embedded in the Flash SWF file
C. device fonts cannot be masked by using a mask layer on the Stage
D. device fonts can only be used with static horizontal text and input text
E. using device fonts results in a somewhat smaller SWF fi le then all of the other font options
Read More Answers.

Question # 49
Which code should be added to create a second blue square to the right of the
first?

Answer:-
A. anotherClip. _ x = 300;
myBit.draw(thisClip);
B. anotherClip.lineTo(300,100);
myBit.draw(thisClip);
C. anotherClip.moveTo(anotherClip. _ x+300,anotherClip. _ y)
myBit.draw(thisClip)
D. anotherClip. _ x = 300;
myBit.duplicateMovieClip(â€œanotherClipâ€•, â€œblueSQâ€•,
getNextHighestDepth());
Read More Answers.

Question # 50
Which two TextField events can be captured to trigger scripts to run? (Choose
two)?

Answer:-
A. onChanged
B. onScrolled
C. onRelease
D. onScroller
E. onClick
Read More Answers.

Question # 51
Which two sets the x position of the instance my_mc to that of the mouse cursor? (Choose two)?

Answer:-
A. my_mc._x=mouse._x;
B. my_mc._xmouse=this._x;
C. _root._xmouse=my_mc._x;
D. my_mc._x=_root._xmouse;
E. my_mc._x==_root._xmouse;
F. my_mc._x=Mouse.addListener(x);
G. setProperty(my_mc,_x,_root._xmouse);
Read More Answers.

Question # 52
What is the purpose of the break statement?

Answer:-
A. to cause a function to stop executing immediately and not run any other
lines of code in a function
B. to cause a conditional loop to stop executing immediately and exit the loop
without running any other lines of code in the loop
C. to stop executing the code in a frame immediately and go to the next frame
without executing any other lines of code in the frame
D. to cause a conditional loop to stop executing immediately, return to the top
of the conditional loop and continue with the next pass of the loop
Read More Answers.

Question # 53
What is the output of the following code?

Answer:-
Code: 
    var fruits:Array = new Array(â€œappleâ€•, â€œstrawberryâ€•, â€œorangeâ€•);
    fruits.unshift(â€œorangeâ€•);
    trace(fruits);
A. apple,strawberry
B. apple,strawberry,orange
C. apple,strawberry,orange,orange
D. orange,apple,strawberry,orange
Read More Answers.
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Question # 54
What appears in the Output window after executing this ActionScript on the first frame of a movie?

Answer:-
Code:
    myVar = 20;
    _ global.myVar = 10;
    trace(myVar);
A. 10
B. 20
C. null
D. error message
Read More Answers.

Question # 55
Which ActionScript classes are used to play FLV formatted video?

Answer:-
A. FlvConnection and FlvStream
B. NetConnection and NetStream
C. ProgConnection and ProgStream
D. NetConnection and FlvConnection
Read More Answers.

Question # 56
You have a rectangle shape with rounded corners. You want to ensure that the corners do
NOT distort when the rectangle is scaled. What should you do?

Answer:-
A. Adjust xscale and yscale properties
B. Convert the shape to a Graphic symbol
C. It's not possible to prevent the corners from scaling
D. Convert the shape to a MovieClip and apply 9-slice scaling
Read More Answers.

Question # 57
You are creating a form that will fade out when the user submits it. What must you do to with the text fields to ensure that text entered by the user will fade out?

Answer:-
A. Embed the font in the text field.
B. Use device fonts in your text field.
C. Set the text field type to dynamic.
D. Choose the Anti-alias for Animation option from the Font Rendering Method pop-up
menu in the Properties panel.
Read More Answers.

Question # 58
Which is the quickest way to make the stroke around an oval shape into a dotted line?

Answer:-
A. Apply the Dotted filter to the stroke of the shape.
B. In the Ink Bottle tool options, set the stroke join type to dotted.
C. Set the stroke type of the shape to dotted in the Properties panel.
D. Choose the Modify > Shape > Convert Lines to Fills option and erase parts
of the stroke to make it appear dotted.
Read More Answers.

Question # 59
Which two panels can be used to change the label text of a Button component? (Choose two)?

Answer:-
A. the Strings panel
B. the Properties panel
C. the Component panel
D. the Accessibility panel
E. the Component Inspector panel
Read More Answers.

Question # 60
You want to skin Flash CS3 components. What should you do?

Answer:-
A. Edit the HaloTheme
B. Edit the SampleTheme
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C. Apply one of the available themes
D. Double-Click a component on the stage and edit the internal graphic
Read More Answers.

Question # 61
Which two are symbol options when converting an object into a symbol? (Choose two)?

Answer:-
A. Video
B. Image
C. Graphic
D. MovieClip
E. Component
Read More Answers.

Question # 62
What happens when you drag an object created with the Oval tool to the Library panel?

Answer:-
A. The oval object is added to the Library as a symbol.
B. The oval object is added to the Library as an object.
C. The oval object is added to the Library as a primitive.
D. The oval object is added to the Library as an imported item.
Read More Answers.

Question # 63
Which two file formats can be imported into a SWF file at runtime? (Choose two)?

Answer:-
A. AI
B. JPG
C. EPS
D. PNG
E. PSD
Read More Answers.

Question # 64
You want to create a Rectangle shape with a defined corner radius. Which tool should you use?

Answer:-
A. Square
B. Rectangle
C. Rectangle Primitive
D. Rectangle Shape Properties
Read More Answers.

Question # 65
You have a dynamically loaded image that is larger than your stage. Which component
would work best to accommodate this image?

Answer:-
A. Window
B. TextArea
C. DataGrid
D. ScrollPane
Read More Answers.

Question # 66
Which text anti-aliasing property setting will result in the smallest SWF file size?

Answer:-
A. Use Device Fonts
B. Anti-Alias for Animation
C. Anti-Alias for Readability
D. Bitmap Text (No Anti-Alias)
Read More Answers.

Question # 67
Which is an advantage of selecting a Flash Player version in Publish Settings before
beginning a project?

Answer:-
A. There is NO advantage. It is identical to choosing them at the conclusion.
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B. Components not available in the targeted player will be removed from the Components
Panel.
C. Classes, Properties, Methods and Events NOT available in the targeted player will be
highlighted in the Script Navigator.
D. Classes, Properties, Methods and Events NOT available in the targeted player will be
removed from the Script Navigator.
Read More Answers.

Question # 68
You are creating a project for the FlashLite player. You are concerned with the processor
capabilities of the device. Which graphic asset would require the most processing power on the player?

Answer:-
A. GIF
B. JPG
C. PNG
D. Vector
Read More Answers.

Question # 69
User accessibility on your video project is a key factor. Which two features should you
choose? (Choose two)?

Answer:-
A. Set showCaptions = true.
B. Use methods of the AccessibleVideo class.
C. Use methods of the UserAccessiblility class.
D. Use Flash 8 Player and the useCaptions method.
E. Use Flash Player 9 with FLVPlayBackCaptioning component.
Read More Answers.

Question # 70
Your company logo is available in the following formats: Illustrator, JPG, PNG, GIF and
PSD. Which format would give you the most options within your Flash project?

Answer:-
A. GIF
B. JPG
C. PNG
D. PSD
E. Illustrator
Read More Answers.

Question # 71
You have a video project that would best be served by using full screen mode. This needs to be done from within the browser, since you are NOT able to use a
projector. Which publish settings should you use?

Answer:-
A. Use Flash Player 7 or higher.
B. Use Flash Player 8 or higher.
C. Use Flash Player 9 or higher.
D. None. FullScreen mode is only possible in a projector.
Read More Answers.

Question # 72
Which is NOT a benefit when adding a title in the Document Properties?

Answer:-
A. The title will be used for your HTML document
B. Metadata will be added for any version of Flash
C. Metadata will be added to the head of the SWF file
D. Metadata can be seen by choosing Publish Settings >Generate Size Report
Read More Answers.

Question # 73
What is the key problem with the following line of code?

Answer:-
Code: 
    aThing = {type:"Monster", teeth:250, bloodtype:K, getName:function(){return this.bloodtype;}}; 
A. It will return an error.
B. .It wastes memory
C. The object will go out of scope as soon as it executes
D. The syntax will become difficult to read as additional complexity is added.
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Read More Answers.

Question # 74
Whitch of the following of code will return "Video" from the following code block?

Answer:-
Code:
    aThing = new Object();
    aThing.mediatype = "Video";
    aThing.format = "DVD";
    aThing.getMediaType = function(){
    return this.mediatype;
    }
A. aThing.getMediaType
B. aThing.getMediaType();
C. aThing.getMediaType{};
D. aThing(getMediaType);
Read More Answers.

Question # 75
What best describes what is happening to the new object being created in the following line of code?

Answer:-
Code:
    Mexico.prototype = new Country();
A. All of its properties and methods will be passed to the country object.
B. All of the country object's properties and methods will be available to the Mexico object.
C. Both A and B.
D None of the above.
Read More Answers.

Question # 76
Tell the difference between indexed array and associative array?

Answer:-
A. Associative array can have values of any type, whereas indexed arrays contain only numbers.
B. Indexed array contain only one type of data, where associative array can have multiple type of data.
C. Associative array contain values indexed by integers, whereas assosiative arrays contain values indexed by string.
D. Associative array contain value pairs, whereas indexed array contain single values.
Read More Answers.

Question # 77
In which of the following situations would it be best to use the Coordinated Universal time (UTC) when using a Date object?

Answer:-
A. When calculating elapsed time on the users machine
B. When communication with a server in an unknown geographical area
C. When accuracy to the millisecond is needed
D. When converting dates to string
Read More Answers.

Question # 78
Which of the following is not true about Capabilities object?

Answer:-
A. Its a property of the system object
B. It is intended primarily for the development of content intended for person with disabilities
C. It provied access to information about the user's machine
D. It does't need to be instantiated to be used.
Read More Answers.

Question # 79
What is the primary purpose of the stage object?

Answer:-
A. To size the flash movie
B. To layer objects on the stage
C. To position objects on the stage
D. To load objects on the stage
Read More Answers.

Question # 80
In general, ,non-MP3 digital audio destined to be imported into the Flash MX authoring environment should first be compressed how much?
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Answer:-
A. 0%(largest file size)
B. 50%(medium file size)
C. 75%(smaller file size)
D. As much as possible (smallest file size)
Read More Answers.

Question # 81
Which of the following is not true about FLV files?

Answer:-
A. They contain video with all the compression selections already applied.
B. They are not comatible with Macintosh OS 9;
C. They con be imported into other movies without a significant delay.
D. When imported,they are treated the same as other imported video files.
Read More Answers.

Question # 82
Which of the following methods can be used to determine if a microphone or a camera is installed on the users machine?

Answer:-
A. System.richmedia.
B. System.accessories
C. System.capabilities
D. System.peripherals
Read More Answers.

Question # 83
Which of the following statements best describes an event handler?

Answer:-
A. A single central script that handles all of the events that take place and determines the appropriate action to take
B. A security function in the root of the timeline that controls access to events
C. A means of allowing an object to notify your scripts of a change of state
Read More Answers.

Question # 84
Which of the following methods is most likely an event handler?

Answer:-
A. MouseDown()
B. _mouseDown
C. MouseDown
D. onMouseDown
Read More Answers.

Question # 85
Which of the following is a true statement about custom event handlers?

Answer:-
A. Their use should be avoided .
B. They can cause handler conflicts with native ActionScript classes.
C. They can inherit from existing ActionScript classe.
D. They are not supported by the Flash 5 Player.
Read More Answers.

Question # 86
What is the downside of Macromedia UI components making extensive use of ingeritance and encapsulation?

Answer:-
A. Global variables cannot be used.
B. Increased file size for first UI component added.
C. UI components cannot be modified.
D. .swf files cannot be loaded at runtime.
Read More Answers.

Question # 87
Which ActionScript method should be used to bring a component from the library to the stage?

Answer:-
A. attachMovie
B. addComponent
C. insertMovie
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D. openComponent
Read More Answers.

Question # 88
Which of the following is NOT a benefit of using Macromedias pre-built UI components:

Answer:-
A. Possible time savings by using pre-written code.
B. Good code examples to learn from.
C. Macromedia UI components stream int the Flash Player over the duration of the main movie timeline.
D. Simple color and font changes are easier to make.
Read More Answers.

Question # 89
Which of the following is NOT a disadvantage of using the fscommand?

Answer:-
A. Your movie becomes tied to a particular host application.
B. You can only have one fscommand in your movie.
C. Its use is not supported by Netscape 6.
D. The host application will not be able to return values to yur fscommand call.
Read More Answers.

Question # 90
Which of the following is the best reason for using the getURL command, instead of the fscommand, when communicating with the host application?

Answer:-
A. getURL can receive return values from the host application.
B. You do not have to use JavaScript to interact with the host application.
C. It is supported by the Flash Player 6.
D. It is compatible with more browsers.
Read More Answers.

Question # 91
Which of the following is the correct way to create an alert box using getURL and JavaScript?

Answer:-
A. getURL = function ("javascript:alert("Hello World"));
B. getURL(alert,"Hello World:");
C. getURL(javascript (alert,'Hello World'););
D. getURL("javascript:alert('Hello World:');");
Read More Answers.

Question # 92
What will be the result of the following line of ActionScript?

Answer:-
Code: 
    print(_root.myClip,"bmax");
A. The myClip and "bmax" movie clips will be printed.
B. A bounding box will be created by the location of the myClip and "bmax" movie clips,and this area will be printed.
C. The myClip movie clip will be printed, and each frame will be scaled to fill the maximum space on the printed page.
D. The largest printable frame in the myClip will be used to determine the bounding box for all frames printed.
Read More Answers.

Question # 93
The class that is inheritingt another is known as the:

Answer:-
A. child class
B. super class
C. sub class
D. base class
Read More Answers.

Question # 94
For methods within objects,what does the keyword this specifically refer to?

Answer:-
A. The object itself
B. The method
C. The movie clip containing the object
D. The root timeline
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Read More Answers.

Question # 95
Which of the following lines of code will create a new object named myObj?

Answer:-
A. myObj = Object();
B. myObj = new Object();
C. new Object.myObj();
D. new Object(myObj);
Read More Answers.

Question # 96
Which of the following method is best for removing an object(e.g.,myObj) from memory?

Answer:-
A. myObj =0;
B. remove myObj;
C. delete myObj;
D. myObj = null Object()
Read More Answers.

Question # 97
Which of the following statements is true about ActionScript in regards to the enforcement of private scope and public scope?

Answer:-
A. It is strongly typed.
B. You can manually set the scope of methods and properties as either private or public.
C. Methods of public scope are only accessible outside the object.
D. There is no enforcement of the private and public scope with ActionScript.
Read More Answers.

Question # 98
Which of the following is NOT a good idea when working with methods:

Answer:-
A. Try to minimize the amount of tasks an individual method provides.
B. Use methods as an interface for use by other objects.
C. Only write one method per object.
Read More Answers.

Question # 99
Which statement best describes a property:

Answer:-
A. A variable assigned to a method.
B. A variable assigned to an object instance.
C. An object's type.
Read More Answers.

Question # 100
Which of the following lines of code will create an object instance of the organism class?

Answer:-
A. Organism = new Class();
B. Organism = new Function();
C. Create new Class(Organism);
D. Organism = new Organism();
Read More Answers.

Question # 101
Which statement best describes what the #initclip num and #endinitclip commands indicate?

Answer:-
A. Ablock of component initialization actions
B. A list of methods associated with an object
C. A block of classes to be inherited from
D.A list of initial property values
Read More Answers.

Question # 102
Which keyword is used to attach methods and properties to a class?
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Answer:-
A. assign
B. prototype
C. inherit
D. declare
Read More Answers.

Question # 103
Which of the following is the key advantage of Flash being a true clientside application?

Answer:-
A. It uses a stateless protocol.
B. It supports the use of ASP and JSP.
C. It provedes rich support of server-side session variables.
D. It can maintain its state without help from the server.
Read More Answers.

Question # 104
When should one generally use the POST method instead of the GET method?

Answer:-
A. When the query string contains periods(.)
B. When the query string contains spaces()
C. When the query string is particularly long
D. When the query string has only one variable
Read More Answers.

Question # 105
Where is the data pulled by a load variables function stored?

Answer:-
A. The targeted array
B. The targeted movie clip
C. The main timeline
D. Any of the above
Read More Answers.

Question # 106
Which of the following is the key advantage of using Loadvars instead of Loadvariables?

Answer:-
A. Data can be loaded to object other than the one making the Loadvars call.
B. It can handle more variables.
C. It is supported by Flash Player 4, 5 and 6
Read More Answers.

Question # 107
Which of the following is not true about Document Type Definitions (DTDs)?

Answer:-
A. They sllow you a means of testing your XML for valid output.
B. They must be referenced when instantiating an XML object.
C. They make your XML data sources more understandable.
D. THey let you create new markup languages.
Read More Answers.

Question # 108
What does the childNodes property contain?

Answer:-
A. The number of child nodes for the current node.
B. The number of child nodes in the current document.
C. An array of all the child nodes for the current node.
D. A true or false value indicating whether the current node has child nodes.
Read More Answers.

Question # 109
What is the primary difference between the XML.sendAndLoad method and the XML.load method?

Answer:-
A. The XML.sendAndLoad method has additional properties for checking an load status.
B. XML.laad loads documents slightly faster,as there is no error checking on the client side.
C. XML.sendAndLoad allows you to send specific XML data to the server
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D. An entire XML document can be sent to the server using XML.sendAndLoad.
Read More Answers.

Question # 110
Which of the following is not true about the XML. ignoreWhite property?

Answer:-
A. If the ignoreWhite property is true,all spaces in the XML document will be ignored.
B. Carriage returns are treated as data if the ignoreWhite property is set to false.
C. With the ignoreWhite property set to true, you can reduce the number of nodes that need to be created during parsing
D. The default value for the ignoreWhite property is true.
Read More Answers.

Question # 111
Which of the following is not a true statement about HTTP?

Answer:-
A. It is a one way request/response protocol.
B. Once a request is made, the server returns the requested resource.
C. With HTTP the server needs to make frequent requests to see if client data has changed.
Read More Answers.

Question # 112
Which of the following is not a true statement about the XMLSocket object?

Answer:-
A. It can only be used to pass XML.
B. It uses a persistent two-way socket.
C. With the XMLSocket object, once the client connects to the server, it stays connected until one side terminates the connection.
D. It can push data from the server to the client..
Read More Answers.

Question # 113
How does an XMLSocket server know when a received message is complete?

Answer:-
A. The XMLSocket. onXMLLoad method is called by the client.
B. The XMLSocket . onLoad method is called by the client.
C. A zero byte is received.
D. The XMLSocket server is unable to determine when a received message is complete.
Read More Answers.

Question # 114
Which of the following steps is not required in order to test or deploy Flash Remoting?

Answer:-
A. Install and configure a supported Web server application environment.
B. Download and install the server-side remoting components
C. Download and install the Flash MX Remoting components
D. Implement a Macromedia UIComponent
Read More Answers.

Question # 115
Which of the following external ActionScript files must you #include in your movie in order to use Flash Remoting?

Answer:-
A. URLRemote . as
B. Gateway . as
C. NetServices . as
D. GetRemote . as
Read More Answers.

Question # 116
Flash Remoting cannot do which of the following?

Answer:-
A. Access data directly from a remotely hosted Web service.
B. Integrate seamlessly with existing Macromedia UIComponents
C. Translate SOAP XML data into native Flash objects.
D. Marshall native Java objects into Flash objects
Read More Answers.
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Question # 117
Which of the following assumptions cannot be made when developing an application for intranet deployment?

Answer:-
A. The connection speed between computers will be generally faster than on the Internet.
B. Users will have the same version of the Flash Player.
C. The computers accessing the application will be pretty similar to each other as far as capability is concerned.
D. Users will have an Internet connection.
Read More Answers.

Question # 118
Which of the following is the most important factor in determining the compatibility of your application?

Answer:-
A. The Flash Player version installed.
B. The operating system installed.
C. The screen resolution.
D. The use of external assets.
Read More Answers.

Question # 119
Which of the following is not a typical host application for the Flash Player?

Answer:-
A. A browser
B. A projector
C. A Java executable
D. A third-party wrapper
Read More Answers.

Question # 120
Which of the following cannot be automatically outputted by the trace action?

Answer:-
A. String values
B. Array values
C. Object instance values
D. Date and Time values
Read More Answers.

Question # 121
Which of the following is not a result of exporting a movie for a debug build?

Answer:-
A. A normal SWF file is created.
B. An SWD file is created in your working ddirectory.
C. The Debug window appears.
D. You can step through each breakpoint you have set in the movie.
Read More Answers.

Question # 122
Which of the following is not an effective means of developing applications that are easy to debug?

Answer:-
A. Separating and encapsulating each feature of your application
B. Avoiding the use of external .as files
C. Creating differnet classes for different tasks
D. Making sure your methods and classes have descriptive names
Read More Answers.

Question # 123
Which of the following is not a key benefit of usability testing?

Answer:-
A. Find out how potential customers will use your application.
B. Direct marketing exposure to test candidates.
C. Identify areas where the product is difficult to use.
D. Receive valuable comments from customers on how to improve the application.
Read More Answers.

Question # 124
At which point can you start usability testing?
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Answer:-
A. Some sketches of the products interface are drawn.
B. The application goes alpha.
C. The application goes beta.
D. The application is code complete.
Read More Answers.

Question # 125
Which of the following is not a guideline for conducting effective usability testing?

Answer:-
A. Avoid leading questions.
B. Provide helpful, step-by-step instructions on how each task should be completed.
C. Ask users to think aloud.
D. Take lots of notes.
Read More Answers.

Question # 126
What is generally considered the ideal group size for usability testing?

Answer:-
A. 1-2
B. 3-5
C. 6-11
D. 11-20
Read More Answers.

Question # 127
When does the Accessibility . isActive () method return true?

Answer:-
A. When the current Flash movie is in an MSAA-compatible browser .
B. When a screen reader is detected
C. When an input device for people with disabilities is detected.
D. When Flash content has been designated as Accessible.
Read More Answers.

Question # 128
Which of the following items cannot be hidden from screen readers?

Answer:-
A. Static text
B. Dynamic text
C. Buttons
D. Movie clips
Read More Answers.

Question # 129
Which of the following properties can be used to control the order in which the user can tab through the elements in a Flash movie?

Answer:-
A. tabOrder
B. tabNumber
C. tabValue
D. tabIndex
Read More Answers.

Question # 130
You have a TextField selected on stage and would like to separate each letter into its own TextField. Which option under the Modify menu allows you to do this?

Answer:-
A. Divide
B. Separate
C. Break Apart
D. Individualize
Read More Answers.

Question # 131
Which of hte following methods provedes the most controlled printing of Flash content?

Answer:-
A. The Flash Player Contextual Menu
B. The print action

Copyright © https://www.GlobalGuideline.COM Page 20/23

https://www.globalguideline.com/interview_questions/
https://www.globalguideline.com/interview_questions/Questions.php?sc=Adobe_Flash_Interview_Questions_and_Answers_
https://www.globalguideline.com/interview_questions/Answer.php?a=At_which_point_can_you_start_usability_testing
https://www.globalguideline.com/interview_questions/Answer.php?a=Which_of_the_following_is_not_a_guideline_for_conducting_effective_usability_testing
https://www.globalguideline.com/interview_questions/Answer.php?a=What_is_generally_considered_the_ideal_group_size_for_usability_testing
https://www.globalguideline.com/interview_questions/Answer.php?a=When_does_the_Accessibility__isActive__method_return_true
https://www.globalguideline.com/interview_questions/Answer.php?a=Which_of_the_following_items_cannot_be_hidden_from_screen_readers
https://www.globalguideline.com/interview_questions/Answer.php?a=Which_of_the_following_properties_can_be_used_to_control_the_order_in_which_the_user_can_tab_through
https://www.globalguideline.com/interview_questions/Answer.php?a=You_have_a_TextField_selected_on_stage_and_would_like_to_separate_each_letter_into_its_own_TextField
https://www.globalguideline.com


Adobe Flash Interview Questions And Answers

Global Guideline . COM

C. The ExportToprinter action
D. The browser file menu
Read More Answers.

Question # 132
Which of the following is NOT a true statement about the Print action?

Answer:-
A. It provides quality vector-based prints
B. It prints all frames ofthe target timeline unless otherwise specified
C. It is CPU intensive
D. It doesn't print alpha channels
Read More Answers.
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